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CAUTION: This information is subject to change without prior notice.  
 
Copyright 2011, Opticon Sensors Europe BV, all rights reserved. 
 
This manual may not, in whole or in part, be copied, photocopied, reproduced, translated or converted to any 
electronic or machine readable form without prior written consent of Opticon Sensors Europe. 
 
THE GENERAL USE AND FUNCTIONING OF THE BAR CODE SCANNER IS DESCRIBED IN THIS 
DOCUMENT. ALSO GENERAL SETUP INSTRUCTIONS TO GET STARTED ARE DESCRIBED IN THIS 
DOCUMENT. FOR FURTHER INSTRUCTIONS CONSULT OPTICON OR YOUR LOCAL DEALER.  
 

 

OPR3301 USER MANUAL (also OPN2002 compatible!) 
(OS version: RBJV0220 / Application version: RFx35534) 
 
This manual describes the features of the OPR3301 as well as detailed instructions on 
how to use, customize and upgrade the software of the OPR3301. It will also briefly 
describe how to use the CRD3301 communication cradle. 
 
For OPN2002 compatibility, please refer to chapter 7. 
 
More product details, additional support and the Universal menu book (to customize the 
OPR3301) can be found at www.opticon.com.  
 
For more information about how to install and use a Bluetooth stack on a third party 
Bluetooth device (like a PC or mobile device), please refer to the manual of the device. 
 

Capabilities of the OPR3301 application 
 
The following features are currently supported: 
 
 Establish a Bluetooth connection with the CRD3301 cradle and transmit barcode 

data as serial data to the RS232 port of the CRD3301. 
 
 Establish a Bluetooth connection with the CRD3301 cradle and transmit barcode 

data as keyboard data to the USB-HID port of the CRD3301. 
 
 Making the OPR3301 connectable (as slave) to allow a remote device to connect 

with your OPR3301 and allow the transmission of its barcode data using the Serial 
Port Profile (SPP) to an (outgoing) Bluetooth virtual COM port. 

 
 Making the OPR3301 connectable (as slave) as a Bluetooth keyboard to allow the 

remote device to connect with your OPR3301 and transmit its barcode data using 
the Human Interface Device (HID) profile as a Bluetooth keyboard. 

 
 iPhone/iPad compatibility 
 
 Make the OPR3301 connect to a remote device (as master) and transmit its 

barcode data using the Serial Port Profile (SPP) to a (incoming) Bluetooth virtual 
COM port. 

 
 Automatic reconnection to a paired remote device (as master) to quickly re-

establish a lost Bluetooth keyboard or serial connection. 
 
 Opticon Universal menu book support to configure barcode decoders, pre- and 

suffixes, change the Bluetooth configurations  
 
 Configuration of the OPR3301 by using Opticon serial commands. 
 
 Storing of barcodes in memory when not connected (batch mode). 
 
 Software upgrading by Bluetooth (SPP profile) using the CRD-3301 cradle or a 

third party Bluetooth dongle. 

http://www.opticon.com/
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Getting started 
 

 
1.1 Selecting the correct interface and connection method 
 
The OPR3301 can establish a Bluetooth connection and transmit its data in various 
different ways.  
 
The first step in determining which method is required in your specific application is 
determining whether you want to receive the barcode data of the OPR3301 as serial 
data (SPP) or as keyboard data (HID). 
 
To make this selection, the following 2 defaults are supported *: 
 

Bluetooth SPP 
(default) 
  

Bluetooth HID 

 
 
* For easy-of-use all configuration labels in this manual can be read without reading the 
traditional SET/END labels. 
 

 
After reading one of the labels above, the OPR3301 will try to transmit its data to the 
CRD-3301, which will then forward the barcode data as either serial data to the RS232 
port of the CRD3301 or as keyboard data to its USB port. 
 
However, the OPR3301 can also transmit its barcode data directly to a remote 
Bluetooth device (like a PC, laptop or mobile device).  
 
If you want to connect the OPR3301 directly with a Bluetooth device, first make sure 
that this Bluetooth device supports the Bluetooth profile that you've selected. This 
means that the manual of your Bluetooth device should explicitly state that it supports 
either Bluetooth SPP or Bluetooth HID profile. (Some mobile devices, like the iPhone, 
do have Bluetooth but don't support the SPP and HID profile) 
 
Then next step is reading the label below to tell the OPR3301 it shouldn't connect to a 
CRD3301, but to a third party Bluetooth device.  
 

Connect to PC  
(or another third party Bluetooth device) 

 
 
More labels to switch between the CRD3301 and a direct Bluetooth connection can be 
found in Universal menu book chapter 2.3.1.  
 
After configuring the interface and connection method it is now possible to connect your 
OPR3301 to the CRD3301 or another Bluetooth device.  
 
On the following pages various connection methods will be described depending on the 
settings above and whether you want to actively connect your OPR3301 to a Bluetooth 
device (master mode) or want a remote device to discover and connect to your 
OPR3301 (slave mode).  
 

 



 3 

1.2 Connecting your OPR3301 to a CRD3301 (using the RS232 cable) 
 
The able to receive barcode data via the CRD3301, first make sure that the CRD3301 
is powered and the RS232 cable of the CRD3301 is connected to the COM port of your 
PC. * 
 
To connect the OPR3301 to the CRD3301 using the RS232 cable, read the Bluetooth 
address label underneath the CRD3301. As soon as the OPR3301 is connected to the 
cradle it will sound a high beep to indicate the connection was successfully established. 
The blue LED of the cradle will also act as connection indicator and will stay on 
continuously when being connected. 
 
As long as the COM port on your PC is still closed the CRD3301 will not accept any 
barcodes, resulting in an error beep and an orange good read LED on the OPR3301 
when reading a barcode. Also the middle indicator LED of the CRD3301 will turn red if 
the COM port is still closed. ** 
 
Use an RS232 monitor program (like Hyperterminal or Appload) to open the COM port 
on your PC or device using the following settings:  
 

 9600 bps 

 8 data bits 

 no parity 

 1 stop bit. 
 
Alternative RS232 settings can be configured using the Universal menu book (chapter 
2.1), if this is required for your application. 
 
After the COM port has been opened you can scan barcodes and the data will be 
displayed in your RS232 monitor program.  
 
* If your PC or laptop does not have serial COM port, then a serial-to-USB convert can 
be used to create a USB Virtual COM port. 
 
** If you don't want the CRD3301 to check the COM port status (= DTR signal), then 
you will have to turn on switch 4, which is located underneath the CRD3301. 
 

ON 1 2 3 4 5 6 

       

       

 
If you move out of range (or turned off) the CRD3301, then the OPR3301 will try to 
reconnect for 5 minutes. Afterwards, you can also reconnect manually by pressing the 
trigger key for 5 seconds or by reading the Bluetooth address label underneath the 
CRD3301 again. 
 
To manually end your connection you can scan the DISCONNECT label (see chapter 
2.3.1 of the menu book). It is also possible to disconnect by pressing the trigger key by 
configuring a 'trigger-to-disconnect' time (see Chapter 2.3.4. of the Universal menu 
book). 
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1.3 Connecting your OPR3301 to a CRD3301 (using the USB-HID cable) 
 
The able to receive barcodes as keyboard data via the CRD3301, first make sure that 
the USB cable is connected between the CRD3301 and your PC. Since the CRD3301 
can be powered by USB it's not necessary to connect the 6.0V power supply as well. 
  
When connecting the OPR3301 to a CRD3301 for the first time, make sure you've read 
the 'Bluetooth HID' default label (see chapter 1.1). Because the CRD3301 will behave 
like a normal USB keyboard it won't be necessary to install any USB-drivers on your 
PC. 
 
To connect the OPR3301 to the CRD3301 read the Bluetooth address label 
underneath the cradle. As soon as the OPR3301 is connected to the cradle it will sound 
a high beep. The blue cradle LED acts as connection indicator and will stay on 
continuously when being connected. 
 
When connected, a scanned barcode should now be transmitted to your PC (or other 
device that supports USB-HID) as keyboard data. 
 
If you move out of range (or turned off) the CRD3301, then the OPR3301 will try to 
reconnect for 5 minutes. Afterwards, you can also reconnect manually by pressing the 
trigger key for 5 seconds or by reading the Bluetooth address label underneath the 
CRD3301 again. 
 
To manually end your connection you can scan the DISCONNECT label (see chapter 
2.3.1 of the menu book). It is also possible to disconnect by pressing the trigger key by 
configuring a 'trigger-to-disconnect' time (see Chapter 2.3.4. of the Universal menu 
book). 

 
 
1.4 Connecting your OPR3301 as Bluetooth keyboard 
 
The first step of connecting your OPR3301 as Bluetooth keyboard to a remote device is 
to make sure you've configured it to Bluetooth HID default and read the 'Connect to PC' 
label (see chapter 1.1). 
 
When using the OPR3301 as Bluetooth keyboard, the remote device always has to 
make the first connection attempt (for security reasons). For this reason you will have 
to make your OPR3301 discoverable and connectable to allow the remote device to 
find, pair and connect to your OPR3301. 
 
To make your OPR3301 discoverable and connectable (for 2 minutes) read the label 
below (this label can also be found in chapter 2.3.1 of the Universal menu book). 
 

Make discoverable and 
connectable _+-DSCO-+_ 

 
When this is done, let your remote device discover all Bluetooth devices in range to find 
your OPR3301.  
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When your OPR3301 has been discovered you can try to let your remote device 
connect with your OPR3301. 
 

 
 
Print screen of an OPR3301 that has been discovered on a PC. 
 
Depending on your Operating system and Bluetooth stack you will either be asked to 
enter any PIN code on your remote device or you will be shown a random PIN code. 
Either way you will be requested to enter that same PIN code on your OPR3301. 
 
If you are requested to enter any PIN code, then it is easiest to choose the last 4 digits 
of the Bluetooth address of your OPR3301 as PIN code, since that is the default PIN 
code of your OPR3301. To skip having to enter a PIN code on your OPR3301, read the 
'Fixed PIN code' label below to configure this. To change this configuration back to 
default again (= entering the PIN code manually) you can read the other label.  
 

Use a fixed PIN code 

 

Enter PIN code manually  
(using numeric direct input labels) 
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If you want to use a different PIN code or you are only allowed to enter a random PIN 
code on your OPR3301, then you will have to enter this PIN code using so called direct 
input labels. These labels can be found below and in the Universal Menu Book (chapter 
4.3.3.). After scanning the PIN code, read the END label to send the PIN code to the 
remote device. 

 
When executed correctly your OPR3301 should now be connected as keyboard and 
should be allowed to scan and transmit barcodes as keyboard data.  
 
In rare cases the remote device does establish the pair, but doesn't automatically 
connect. In this situation you might have to connect manually afterwards by pressing 
the trigger key for 5 seconds. 
 
If you've lost your connection, then the OPR3301 will try to reconnect automatically for 
5 minutes (by default). If this fails you can reconnect manually by pressing the trigger 
key for 5 seconds.  
 
The trigger key allows you to reconnect without having to enter the PIN code again as 
long as the remote device doesn't lose the pairing information and the OPR3301 isn't 
reset to default or unpaired. 
 
If the pair was ever lost or you want to connect to another remote device you will have 
to use the procedure on the previous page to make your OPR3301 connectable again 
to allow the remote device to connect and pair with your terminal. 
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1.4.1 Connecting your OPR3301 to an iPhone/iPad/iPod * 
  
This feature requires RFJ35534 with OS version RBGV0220 or higher.  
 
*Note: iOS 4.0 or higher is required 
 

The first step of connecting your OPR3301 is to put it into Bluetooth HID mode and 
reading the 'Connect to PC' label (see also chapter 1.1). 
 

Bluetooth HID  

 
 

Connect to PC  
(or another third party Bluetooth device) 

 
 
Use the left label below to put your OPN2002 in iPhone/iPad mode. This makes it possible 
to toggle the on-screen keyboard while being connected by double-clicking on the trigger 
key*. 
 
* Use the small button on the OPN2002 to toggle the onscreen keyboard. 

 

_+-IOSON-+_   _+-IOSOFF-+_ 

   Enable iPhone/iPad mode                                  Disable iPhone/iPad mode 
 
Pressing the trigger key will now also wake up the iPhone/iPad from standby. It is 
recommended to disable the passcode lock option to prevent barcodes from being 
entered as passcode when waking up from standby.   
 
When using the OPR3301 as Bluetooth keyboard, the remote device always has to 
make the first connection attempt (for security reasons). For this reason you will have 
to make your OPR3301 discoverable and connectable to allow the iPhone/iPad to find, 
pair and connect to your OPR3301. 
 
To make your OPR3301 discoverable and connectable (for 2 minutes) read the label 
below (this label can also be found in chapter 2.3.1 of the Universal menu book). 
 

Make discoverable and 
connectable _+-DSCO-+_ 

 
When this is done, turn on Bluetooth on your iPhone. The iPhone will now automatically 

discover your OPR3301. Once discovered, select the OPR3301 on your iPhone. 
 
Once chosen, the OPR3301’s laser will light up and you will hear a steady beep. Use the 
number barcodes provided in chapter 1.4 to scan the displayed pin code; one number at a 
time. When you are done, scan ‘END’ to complete the pairing. 
 
Your OPR3301 is now paired and connected. The LED blinks blue slowly to indicate a 
connection is active and working. Any barcode data you scan will now appear on the screen 
as if you had typed it. Please have an application open that allows typing data. 
 
Note, if for any reason your OPN2002 becomes unpaired with your other device (e.g. host 
device goes to sleep, battery loss, etc.), you can simply hold the scan key for five seconds 
to reestablish the connection. 
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1.5 Connecting your OPR3301 as a Bluetooth Virtual COM port (VCP) 
 
The first step of connecting your OPR3301 as Bluetooth Virtual COM port to a third 
party Bluetooth device is to make sure you've configured it to Bluetooth SPP default 
and read the 'Connect to PC' label (see Chapter 1.1). 
 
When using Bluetooth SPP, the remote device can either connect to your OPR3301 
(slave mode) or your OPR3301 can connect to remote device (as master). 
 
If you want the OPR3301 to connect to a remote device (as master) it will be necessary 
to configure the Bluetooth address of the remote device first. 
 
Usually the address is displayed on the product label as a hexadecimal code (example: 
00-11-F6-03-39-69). Otherwise consult the documentation of the device to learn how to 
retrieve the Bluetooth address. To configure this Bluetooth address in the OPR3301 
you'll have to create a barcode label containing this hexadecimal code. 
 
Opticon provides a simple on-line application to create a barcode label containing a 
Bluetooth address. This application can be found at: 
 

http://opticonfigure.opticon.com/bluetooth.asp  
 

 
Print screen of the online Bluetooth address label generator. 
 
Type in the 12 digits of the address using numbers and capitals without dashes, dots 
and spaces (example: 0011F6033969) and press submit. 
 
After you've created the barcode, you can print it and should scan the barcode to 
configure the Bluetooth address and save it in non-volatile memory. (The OPR3301 will 
automatically to try to establish a Bluetooth connection when reading this label). 

http://opticonfigure.opticon.com/bluetooth.asp
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1.5.1 Connecting the OPR3301 as master  
 
Depending on the Operating System and Bluetooth stack of your PC, laptop or mobile 
Bluetooth device, it is often necessary to first open the (incoming) Bluetooth Virtual 
Com port, before you will be able to connect your OPR3301 as master to your device. 
Using applications like Hyperterminal or the RS232 monitor of Appload it is possible to 
open the (incoming) Bluetooth Virtual Com Port. For more information on how to open 
a COM port, please refer to documentation of your remote Bluetooth device. 
 
The first time you try to connect your OPR3301 to a Bluetooth device you will have to 
scan the created Bluetooth address label. Once the Bluetooth address is configured, it 
will also be possible to do a connection attempt by pressing the trigger key for 5 
seconds. 
 
If you haven't disabled authentication on your remote device, then you will be 
requested to enter a PIN code (passkey). The default PIN code of the OPR3301 equals 
the last 4 digits of the Bluetooth address. These last 4 digits of the Bluetooth address 
are also shown in the Bluetooth name of the OPR3301. If you wish to use a different 
PIN code, then this is possible by using the 'Set/End PIN-code' menu labels, which can 
be found in chapter 2.3.2 of the Universal menu book. 
 

 
 
Example of a request on a Windows device to enter a PIN-code (passkey) 
 
When executed correctly your OPR3301 should now be connected as Virtual Com port 
to your remote device and you should be able to scan and transmit barcodes as serial 
data. 
 
If you've lost your connection or closed the virtual COM port, then the OPR3301 will try 
to reconnect for 5 minutes (by default). You can also reconnect manually by pressing 
the trigger key for 5 seconds, read the Bluetooth address label again or by reading the 
CONNECT label (see chapter 2.3.1 of the menu book).  
 
To manually end your connection you can scan the DISCONNECT label (see chapter 
2.3.1 of the menu book). It is also possible to disconnect by pressing the trigger key by 
configuring a 'trigger-to-disconnect' time (see Chapter 2.3.4. of the Universal menu 
book). 
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1.5.2 Connecting to the OPR3301 as slave 
 
When you want the remote device to connect with your OPR3301, then it is not 
necessary to create and scan a Bluetooth address label, but you will have to make your 
OPR3301 discoverable and connectable to allow the remote device to find and connect 
to your OPR3301. 
 
To make your OPR3301 discoverable and connectable (for 2 minutes) read the label 
below (this label can also be found in chapter 2.3.1 of the Universal menu book). 
 
 

Make discoverable and 
connectable _+-DSCO-+_ 

 
 
When this is done, let your remote device discover all Bluetooth devices in range to find 
your OPR3301.  
 

 
Print screen of an OPR3301 that has been discovered on a PC. 
 
When you've successfully discovered your OPR3301, you can try to let your remote 
device pair with your OPR3301 (unless you've disabled authentication on your 
Bluetooth device).  
 
During this step you will be requested to enter a PIN code (passkey) on your remote 
device. The default PIN code of the OPR3301 equals the last 4 digits of the Bluetooth 
address. These last 4 digits of the Bluetooth address are also shown in the Bluetooth 
name of the OPR3301. If you wish to use a different PIN code, this is possible by using 
the 'Set/End PIN-code' menu labels, which can be found in chapter 2.3.2 of the 
Universal menu book. 
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Screenshot of entering a passkey (PIN-code) on a Windows device 
 
If successful, the OPR3301 should now be successfully paired with your remote 
Bluetooth device and the Virtual Com port should be ready to be used.  
 
To be able to scan and transmit barcodes as serial data open the Bluetooth Virtual 
Com port on your remote device to establish the connection with the OPR3301 
 
If you've lost your connection or have closed the COM port, then the OPR3301 will stay 
connectable for 5 minutes (by default). After this period, you'll need to read the 'make 
discoverable and connectable' label again to allow the remote device to re-establish the 
connection. 
 
It is also possible to make the OPR3301 connectable again by pressing the trigger key 
by configuring a 'trigger-to-connect' time in combination with the 'Trigger to make 
connectable' option (see Chapter 2.3.3. of the Universal menu book). 
 
To manually end your connection you can scan a DISCONNECT label (see also 
chapter 2.3.1 of the menu book).  
 

Manually disconnect _+-DISC-+_ 

 
It is also possible to disconnect by pressing the trigger key by configuring a 'trigger-to-
disconnect' time (see Chapter 2.3.4. of the Universal menu book). 
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2 Bluetooth connection labels 
 
Below you will find a list of connection control labels, which can be useful to quickly 
reconnect or disconnect your OPR3301.  
 

Manually connect _+-CONN-+_ 

Manually disconnect _+-DISC-+_ 

Make discoverable and 
connectable _+-DSCO-+_ 

Manually unpair * _+-UNPR-+_ 

 
* Note: Reading the 'unpair' label will force the OPR3301 to redo the pairing on the next 
connection attempt. This can be useful in situations that you don't want unauthorized 
people to connect your OPR3301 to your remote device. 

 

3 Bluetooth configuration options 
 
The OPR3301 has various special configuration options to customize the OPR3301 to 
your own preferences. Below these options will be briefly mentioned. For more 
information and the actual configuration labels to use these options, please refer to 
chapter 2.3 of the Universal menu book. 
 

3.1 Configuring a Bluetooth address without Bluetooth address label 
 
In case you're in the situation that you want to connect the OPR3301 to a Bluetooth 
device, but you don't have the possibility to print a Bluetooth address label containing 
the Bluetooth address, then it's also possible to configure the Bluetooth address using 
the Universal menu book. The Set/End Bluetooth address labels can be found in 
chapter 2.3.1 including more information on how to use them. The direct input labels of 
chapter 4.3.3 can be used to enter the 12 digits of the Bluetooth address. 
 

3.2 Bluetooth security options  
 
In situations that you want a more secure Bluetooth connection there are a couple of 
menu options available for this purpose. Using these options it is possible to change 
the default passkey (PIN-code), enable encryption and make authentication mandatory. 
These options are described in chapter 2.3.2 of the Universal menu book. It's also 
possible to read the unpair label on the previous page to ensure that the OPR3301 
needs to pair again the next time it is used. 
 

3.3 Trigger-to-connect options 
 
By default the OPR3301 can reconnect by pressing the trigger key for 5 seconds. This 
option can be disabled and also the time of 5 seconds can be changed between 1 and 
9 seconds.  
 
When you're using the OPR3301 in slave mode, it's also possible to make your 
OPR3301 discoverable and connectable again by pressing the trigger key by enabling 
the 'Trigger to make connectable/discoverable' option. 
 
More information about these options can be found in chapter 2.3.3 of the Universal 
menu book.  
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3.4 Trigger-to-disconnect options 
 
By default the OPR3301 won't disconnect by pressing the trigger key to avoid 
unwanted disconnects while reading barcodes. However, it is possible to enable this 
feature by configuring a 'trigger-to-disconnect' time between 1 and 9 seconds. These 
options can be found in chapter 2.3.4 of the Universal menu book. 
 

3.5 Auto disconnect options 
 
To save power, it's possible to automatically let the OPR3301 disconnect if it has been 
idle for the configured time (ranging between 10 and 60 minutes. Using chapter 2.3.5 of 
the Universal menu book the OPR3301 the auto disconnect time can be configured. 
 

3.6 Auto reconnect options 
 
By default the OPR3301 will try to reconnect after a connection loss for 5 minutes. 
(When using the OPR3301 in slave mode it will stay connectable for 5 minutes to allow 
the remote device to reconnect.) This reconnect time is configurable and it can also be 
disabled. These options can be found in chapter 2.3.6 of the Universal menu book. 
 

3.7 Memorizing / batch mode options 
 
The OPR3301 has the possibility to temporarily store barcodes in its memory when you 
don't have an active Bluetooth connection between your OPR3301 and the CRD3301 
(or another Bluetooth device). As soon as the reader is connected again, the temporary 
stored data is transmitted and the storage area is cleared. 
 
By default this functionality is disabled, but to enable this functionality use the menu 
labels that can be found in chapter 2.3.8 of the Universal menu book.  
 
When enabled, the OPR3301 will only temporarily store barcodes when the connection 
was lost. This means that it won't be enabled before a connection was ever established 
and also not after a manual disconnect. In case you always want to have memorizing 
enabled when not connected use the 'always memorize when not connected' option.   
 
It is also possible to use the OPR3301 as batch scanner, meaning it will always store 
all scanned barcodes until you explicitly tell it to transmit its data. This option is called 
'Memorize always (Batch mode)'. To transmit the data, read the +-MXMT-+ label that 
can be found in the same chapter. 
 
Chapter 2.3.8 also contains a couple of labels to manually start or stop memorizing, 
which will overrule the options mentioned above. There's also a label that can clear the 
memory of the OPR3301 in case you no longer need the stored barcode data. 
 
The OPR3301 stores the barcodes in RAM memory. The size of this memory is almost 
1MB large, so you could theoretically scan barcodes for days without it becoming full. If 
the battery of the OPR3301 becomes empty it won't immediately lose its stored 
barcode data. However, if an empty OPR3301 isn't charged within the next few days it 
will eventually lose the stored barcode data. 



 14 

4 General configuration options  
 

4.1 Opticon Universal menu book 
 
The OPR3301 supports various configuration options that can be found in the Opticon 
Universal menu book. This makes it possible to customize the OPR3301 to your own 
needs and requirements. The latest Universal menu book can always be found on our 
web site. 
 
The OPR3301 supports (most of the) menu options listed in the following chapters: 
 
 1. Defaults (Bluetooth SPP, Bluetooth HID) 
 2.1. RS232 options (for the CRD3301 only) 
 2.2.1. Keyboard language 
 2.2.2. Special keyboard options 
 2.3. Bluetooth options (See chapter 3) 
 3.1  Enabling/disabling readable codes * 
 3.2  Setting of fixed, minimum and maximum lengths 
 3.3  Code specific options (almost all options are supported except some 2D 

decoder options) 
 4.1  Case conversion 
 4.2  Set prefixes 
 4.3  Set suffixes 
 5.1  Read modes, add-on wait modes, trigger repeat 
 5.1.1 Multiple read reset time 
 5.1.2 Quite zone options (margins) 
 5.2  Read time options 
 5.4  Redundancy 
 5.5  Positive and negative barcodes 
 6     Indicator options (Buzzer and good read LED options) 
 7.1  Diagnostics 
 7.2  Serial configuration options  (excluding 'disable laser' and 'error message' 

options) 
 
The following barcode types can be read by the OPR3301: 
 
 EAN 8, EAN-13, UPC-A, UPC-E, UPC-E1 
 Code 39 + Full ASCII 
 Code 93 
 Code 128 / EAN 128 
 Interleaved 2 of 5 / Industrial 2 of 5 
 IATA 
 MSI plessey 
 S-Code / Matrix 2of5 / Chinese post 2of5 
 Telepen 
 UK/Plessey 
 Tri-optics 
 Italian Pharmaceutical 
 Codabar Normal, ABC, CX 
 ISBN, ISSN, ISMN 
 All GS1 DataBar variants (formerly known as RSS) 

 Korean Postal Authority code 
 PDF417 / MicroPDF417 / EAN•UCC Composite codes 
 Codablock-F 
 

5 Configuration via serial commands 
 
When using the Bluetooth SPP default (see chapter 1.1) it is also possible to configure 
the OPR3301 by sending serial commands to the OPR3301. More information about 
the use of serial (RS232)-commands can be found in Chapter 0 of the Universal menu 
book.  
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6 Software on the OPR3301 
 
In the future more features (or bug fixes) will be implemented into the software of the 
OPR3301. To find out if there are software (or manual) updates available, please check 
our web site. All available software and documentation can be found under:  
 

'Service and support' > 'Software' / 'Manuals' > 'OPR3301' at www.opticon.com. 
 
 

6.1 Retrieving the current software version 
 
If you want to check the currently installed software versions, it is possible to transmit 
the software versions by first establishing a Bluetooth connection and then reading the 
'Z1' menu label below (See also Universal menu book chapter 7.1). This will output the 
software versions as either keyboard data or as serial data. 
 

Show software version(s) 

 

 
The retrieved software versions of the OPR3301 consist of 3 parts:  
 
 Operating System (OS). This part of the software controls all hardware and can 

run an application. The software version of the OS will always have the following 
format: 

 

RBJVxxxx  where xxxx is the number software release 

 
 Application. This part of the software implements the user interface of the 

OPR3301 like the handling of the trigger key and processing scanned barcodes 
(transmit, store or configure). The software version of the application will usually 
have the following format: 
 

RFJ3553x  where x is the version number* 

 
* Note: The OPR3301 has the ability to run customized applications (just like the 
OPN2002 terminal). However, this manual will only describe the default application 
for the OPR3301. 

 
 Boot loader. This part of the software boots the OPR3301. The boot loader is like 

the BIOS of a PC. It is not subject to change in the future, so no boot loader 
software updates will be available on our web site. 
The software version of the boot loader will have the following format: 
 

RAJVxxxx  where x is the version number 

 
 

http://www.opticon.com/
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6.2 Updating the OPR3301 

 
On the following pages detailed instructions will be given on how to load new software 
on the OPR3301.  
 
To be able to upgrade the OPR3301 you will either need the CRD3301 or a PC with a 
third party Bluetooth dongle that supports Bluetooth SPP. 
 
Please read these following instructions carefully before starting to update your 
software. 
 
Important notes: 
 

 The OPR3301 uses the barcode storage area to temporarily store the new 
software before loading the new software in non-volatile memory. Because of this, 
be aware that any barcode data that may still be present in the OPR3301 will be 
erased. 

 

 After upgrading the OPR3301 will automatically reset to factory default, so if you're 
using customized settings, these settings will have to be reconfigured using this 
manual or the Universal menu book. 

 
To update the OPR3301, it is required to first put the OPR3301 in Bluetooth SPP 
mode, since it is not possible to upgrade using Bluetooth HID. 
 
Read the default label below configure the OPR3301 in Bluetooth SPP mode 
 

Bluetooth SPP 
(default) 
  

 
Also you will need the latest version of the Opticon upgrade application, called 
Appload, installed on your PC. Appload can be found on our web site at:   
 

'Service and support' > 'Software' > 'Appload' at www.opticon.com. 

 
 
6.2.1 Updating the OPR3301 using the CRD3301 
 
 
Step 1: Configuring the CRD3301 
 
By default the OPR3301 will try to connect to a CRD3301, so you won't have to 
explicitly configure this. However, if you want to make sure, you can always read the 
label below. 
 

Connect to cradle 

 

 
Even though it's possible to upgrade the OPR3301 as the default baud rate of 9600, 
upgrading would take a couple of minutes longer than necessary. For this reason it is 
recommended to first read the label below to configure the best baud rate for upgrading 
the OPR3301. 
 

Baud rate: 38400 

 

 

http://www.opticon.com/
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The next step is configuring the CRD3301 at the correct baud rate as well. This can be 
done as follows: 
 

 Read the Bluetooth address label underneath the CRD3301 cradle 
 

 Wait until the OPR3301 has successfully connected to the CRD3301 and thereby 
configured the baud rate. 

 

 Read the label below to manually disconnect 
 

Manually disconnect _+-DISC-+_ 

 
The last step is to configure the CRD3301 as a Bluetooth-to-RS232 dongle. This can 
be done as follows: 
 

 Remove the power from the CRD3301  
 

 Change the switches underneath the CRD3301 to the following set-up: 
 

ON 1 2 3 4 5 6 

       

       

 

 Make sure you've connected the RS232 cable between your PC and the 
CRD3301 

 

 Reconnect the power supply 
 
 
Step 2: Configuring the OPR3301 and establishing a Bluetooth connection 
 
Since your CRD3301 will now behave like a Bluetooth dongle that's attached to a PC, it 
is also necessary to configure your OPR3301 as if it's connected to a PC. Read the 
label below to make this configuration. 
  

Connect to PC  
(or another third party Bluetooth device) 

 
 
The following step is connect your OPR3301 to the CRD3301 again and open the COM 
port on your PC by using the following steps. 
 

 Read the Bluetooth address label underneath the CRD3301 cradle 
 

 Wait until the OPR3301 has successfully connected to the CRD3301 
 

 Start Appload on your PC and open the RS232 monitor of Appload, using: 
 

Utilities > Show RS232 data 
 

 Select the following communication settings in Appload 
 

Settings > Port > COM x   (where x is the number of your RS232 port) 
Settings > Baudrate > 38400 
Settings > Databits > 8 
Settings > Parity > None 
Settings > Stop bits > 1 
Settings > Format > Normal (or ASCII) 
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Step 3: Downloading 
 
When the OPR3301 is connected and Appload has been correctly configured you can 
now start the download procedure by reading the label below. 
 

Enter download mode _+-DOWNLOAD-+_ 

 
As a result of this the OPR3301 should start blinking the green LED and the following 
message should appear on your screen. 
 

 
 
Now open the software file that you want to download on the OPR3301 using: 
 

File > Transfer  > Transmit NetO file. 
 
The downloading of the software should now start. Underneath the screen a progress 
bar will be shown to indicate the progress of the software downloading. 
 
The loading of a new application generally will take less than a minute. Loading a new 
Operating System can take between 3 and 10 minutes depending on the file type (bin-
files are faster than hex-files) and the quality of the Bluetooth connection.  
 
When the downloading is complete, Appload will show a message on the screen that 
the uploading was successful. * 
 
If the received files are found to be ok, then the OPR3301 will start installing the 
software. This can take up to 15 seconds to complete. 
 
In case the OPR3301 detects that the uploaded file is not compatible it will sound a low 
error beep and no software will be installed. 
 
If the installation was successful the OPR3301 will reset and will sound the start-up 
buzzer.  
 
* Note: No message will be shown on the screen that indicates whether the software 
was installed successfully or not, because the Bluetooth connection is closed before 
the installation starts. Listen to the response of the OPR3301 instead. 
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Step 4: Reset the CRD3301 and OPR3301 back to default 
  
When the installation was successful read the default label that suits your application 
and reconfigure your OPR3301 if any custom configurations were used previously. 
 

Bluetooth SPP 
(default) 
  

Bluetooth HID ** 

 
 
 
Also don't forget to put the switches underneath the CRD3301 back to default. 
 

ON 1 2 3 4 5 6 

       

       

 
 
 
6.2.2 Updating the OPR3301 using a third party Bluetooth dongle * 
 
The first step of upgrading the OPR3301 using a third party Bluetooth dongle is to 
establish a working Bluetooth SPP connection.  
 
There is however a difficulty when creating a working a SPP connection for 
downloading. Many Bluetooth stacks (like the Microsoft stack) disconnect the Bluetooth 
connection as soon as a Bluetooth COM port is closed. This makes upgrading 
impossible when the OPR3301 is connected as master, since the COM port is closed 
by Appload for a short period before starting the download. ** 
 
For this reason it's better to establish a Bluetooth SPP connection in slave mode. (See 
chapter 1.5.2 for more information on how to establish a connection as slave.) 
 
When the OPR3301 is connected as slave. Continue with step 3 on the previous page 
to download the software on the OPR3301. 

 
 
* Most available Bluetooth dongles can be used for downloading software on the 
OPR3301. However it can't be guaranteed that the loading of the software will work on 
all types of Bluetooth dongles, because the timing, speed and buffer size of some 
dongles make it impossible to be used for downloading software. 
 
** During tests only the WIDCOMM Bluetooth stack was able to load software in master 
mode. All other tested Bluetooth stacks required the OPR3301 to be connected as 
slave. 
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7 OPN2002 compatibility 
 
This application for the OPR3301 is also compatible with the OPN2002. This 
compatibility makes it possible to use the unique features of the OPR3301 that aren't 
available in the Bluetooth demo application software of the OPN2002.  

 
This includes the following features: 

 Memorizing (automatic, manual and batch mode) 

 Support of buzzer, LED and trigger control using serial commands 

 CRD3301 support (disabled by default; use 'Connect to cradle' to enable) 

 Bluetooth options:  

 Auto disconnect time 

 Disable auto connect (on reading a Bluetooth address label) 
 

7.1 2-Button interface of the OPN2002 
 
The OPN2002 has the advantage over the OPR3301 of having 2 keys instead of just 1. 
This makes the user interface of the OPN2002 a little more user friendly.  
  
For this reason the OPR3301 application will behave slightly different on the OPN2002 
in the following situations: 
 

 To manually disconnect using the Trigger-to-disconnect functionality, the small key 
should be pressed instead of the trigger key. This avoids accidentally 
disconnecting while reading barcodes. 

 

 On the OPN2002 the Trigger-to-disconnect functionality is enabled by default. The 
default time is 5 seconds. 

 

 The small key of the OPN2002 can be used to make the OPN2002 discoverable 
and connectable (as slave) for 2 minutes.  

 

7.2 Minimal required OS version 
 
To be able to use all functionality of this application on the OPN2002, the minimal 
required OS software for the OPN2002 is RBGV0212 (recommended version for 
memorizing: RBGV0220). This software can be found on our web site and can be 
loading on the OPN2002 using the mini-USB cable or the CRD2000 cradle.  
 

7.3 Loading software on the OPN2002 
 
Both OS and application files for the OPN2002 can be loaded by using a small PC 
application called Appload, which can be download from our web site.  
 
The OPN2002 uses a different Operating System version than the OPR3301. Before 
trying to load new software on the OPN2002, make sure the file contains the following 
3-letter code indicating it’s an OPN2002 file.  
 
 

Terminal OS Application 

OPN2002 RBG RFG* 
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* It is possible to load an OPR3301 application file (software code: RFJ) on the 
OPN2002, because the hardware is mostly the same. The only main differences are 
the presence of an USB connector and RS232 cradle contacts on OPN2002.  
 
Loading new software on the OPN2002 is fastest using the mini-USB cable. To be able 
to communicate with an OPN2002 terminal using USB, you will need to have its USB 
driver installed on your PC. This driver can be found on our web site on the 'Service 
and Support' page. 
 
www.opticon.com/SERVICE-AND-SUPPORT.aspx 
 
The driver can be found in the section called 'Software' and then selecting the 
OPN2002. 
 
Two drivers can be downloaded for the OPN200x: 
 

optousb32.exe 
USB driver for Windows 2000, Windows XP (32bit),  
Windows Vista (32bit), Windows 7 (32 bit)  

optousb64.exe 
USB driver for Windows XP (64bit), Windows Vista (64bit),  
Windows 7 (64 bit) 

 
After installing the USB driver, you can connect your OPN2002 to an USB port using a 
mini-USB cable. Windows will then automatically install a virtual COM port on your PC, 
which can be selected in Appload (and other RS232 monitoring applications). 
 
On the following page instruction will be given on how to load software on the 
OPN2002 using either the mini-USB cable or the CRD220 cradle 
 
To load an OS or application file on the OPN2002, please follow the instructions below. 
 

 
USB Cable 

 Connect the OPN2002 to your PC or laptop using the mini-USB cable 
 Start Appload and select the (Virtual) COM port of your OPN2002 in Appload. 
 Select the OS or application file in Appload using File > Download 

 
Multi Cradle 

 Place one OPN2002 in the cradle 
 Start Appload and select the COM port of the CRD2000 cradle. 
 Select the OS or application file in Appload using File > Download. 
 Wait until the downloading has finished before inserting another OPN2002 in the 

cradle. 

 
Bluetooth 

Although it's not recommended, it's also possible to upgrade the OPN2002 using 
Bluetooth. To load software via Bluetooth you'll need to have OS version RBGV0211 
or higher already installed on your OPN2002. See the software updating instruction 
for the OPR3301 in chapter 6 for instructions. 

 
7.4 iPhone/iPad support on the OPN2002 
 
For connecting your OPN2002 to an iPhone or iPad, see chapter 1.4.1 of this manual 

or download the OPN2002 quick start guide for the iPhone/iPad from at 
www.opticon.com. 

http://www.opticon.com/SERVICE-AND-SUPPORT.aspx
http://www.opticon.com/
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OPL7724, CRD7724 and OPL2724 compatibility 

 
The predecessors of the OPR3301 and OPN2002 are respectively the OPL7724 and 
the OPL2724.  
 
Compared to these older Opticon barcode readers the OPR3301 and the OPN2002 
offer more functionality, like the support of USB-HID (using the CRD3301), Bluetooth-
HID interface, more decoder options and the ability to run custom applications. 
 
However there are a few incompatibilities that need to be reconsidered before replacing 
the OPL7724 or OPL2724 by an OPR3301 or OPN2002. These incompatibilities are 
listed below: 
 
 The CRD33301 cradle currently does not support USB-VCP (like the CRD7724), so 

an RS232-to-USB dongle would be required to convert the RS232 output to USB-
VCP. 

 
 The CRD3301 currently does not support the baud rate 115200 bps 
 
 The default trigger-to-connect time of the OPR3301 is 5 seconds in contrary of 

being disabled on the OPLx724. See chapter 2.3.3 of the Universal menu book. 
 
 When connecting to a PC, the default PIN-code of the OPR3301 equals the last 4 

digits of its own Bluetooth address, in contrary of OPLx724 that uses an empty 
PIN-code. 

 
 The CRD3301 cradle is incompatible with the CRD7724. For this reason the 

OPR3301 can't connect to or be charged in the CRD7724. 
 
 The 1-character menu commands: Disable / Enable laser are not yet supported 
 
 The OPR3301 software currently has no low battery indicator outside the cradle 
 

 The OPR3301 has a lithium-ion battery of 1100mAh, which is almost twice the 
capacity of the OPL7724 (600mAh). Also the battery consumption when being 
connected and when being idle is much lower on the OPR3301, causing it to have 
a much longer operation time. 

 
 The OPL2724 uses 2 AAA dry-cell batteries, while the OPN2002 uses an 

embedded rechargeable lithium-ion battery of 250mAh. Even though the capacity 
of the OPN2002 is much smaller, the operating time isn't always shorter, because it 
uses much less power when being idle and to maintain a Bluetooth connection. 
However, when scanning and transmitting barcodes very frequently the OPL27274 
will have a longer operating time. 
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8 Trouble shooting 
 
Since the OPR3301 has no display, it also doesn't have a system menu to resort to 
when you've installed a wrong application that prevents you from loading new software 
on the OPR3301 or when the OPR3301 is no longer responding for some reason. 
 
For this reason the OPR3301 has a few escape mechanisms that allow you to restart 
or temporarily halt the application to be able to install new software.  
 

8.1 Restart mechanisms 
 

Automatic 

The OPR3301 has a watchdog timer to determine whether the OS is still 
running or has crashed. This watchdog will cause the OPR3301 to restart after 
3 seconds if the OS has crashed. This watchdog timer will not cause a restart 
when only the application has crashed.  
 
Since OS version RBGV0220 the software of the OPN2002 is also protected 
against electrical static discharges (ESD). If the OPN2002 has stopped 
working due to an ESD it will automatically recover within a minute. 

Manually 

The OPR3301 has a manual restart mechanism that allows you to restart in 
situations that the OS is still running, but your the application has crashed. In 
order to activate this mechanism, press and hold the trigger key for at least 20 
seconds. After the OPR3301 has sounded the restart beep, you can release 
the key to complete the restart.  

 
 

8.2 Halting your application 
 
 First make sure the battery isn't empty and the OPR3301 is not lying in the 

CRD3301 cradle. 
 Restart your application using one of the two restart methods listed above, but 

keep the trigger key pressed. 
 While keeping the trigger key pressed, place the OPR3301 in the CRD3301 cradle 

and release the trigger key. 
 
If successful, the LED of your OPR3301 should start blinking orange after 3 seconds.  
 
You should now be able to establish a Bluetooth connection (see chapter 1.5.2.), which 
will allow you to load new software on the OPR3301 using a third party Bluetooth 
dongle or the CRD3301 cradle (at a default baud rate of 9600). See chapter 6 for more 
information.  
 
To exit the halted-application state, press the trigger key again for 20 seconds or load 
new software. 
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9 Version history 
 

OS: RBJV0211 
AP: RFJ35530 

First release of software and manual March 9
th
, 2009 

OS: RBJV0216 
AP: RFJ35531 

Fixed memorizing problems 
Fixed Bluetooth connection issues 
Fixed problems related to losing Bluetooth pair 

November 1, 2010 

OS: RBxV0220 
AP: RFG35532 

Fixed repeating key problem on iOS (OPN2002) 
Added wake-up by trigger on iOS (OPN2002) 
Added ESD protection (OPN2002) 

May 11, 2011 

OS: RBxV0220 
AP: RFJ35533 

Fixed incorrect suffix in HID mode when 
connected to CRD3301 (OPR3301) 

March 1, 2012 

OS: RBxV0220 
AP: RFJ35534 

Improved iPhone/iPad support (OPR3301) November 29, 2012 

 

Please check our web site at www.opticon.com to see if there are updates 
available for the Operating System, application and/or this manual. 
 

http://www.opticon.com/
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